Contents

1 Introduction .............................................. 1
   1.1 About the KD2 Pro ......................................... 1
   1.2 Shipping Contents .......................................... 1
   1.3 Customer Support ........................................... 2
   1.4 Warranty Information ........................................ 3
   1.5 Seller’s Liability ........................................... 3

2 KD2 Pro Overview ........................................... 5
   2.1 Specifications ................................................ 5
   2.2 Keypad Operation ............................................. 8
   2.3 Choosing a Sensor ........................................... 9
   2.4 KD2 Pro Sensor Compatibility .............................. 14
   2.5 Installing the Sensors ...................................... 16

3 The Menus ................................................... 17
   3.1 The Main Menu ............................................... 17
   3.2 The Data Menu ............................................... 19
   3.3 The Configuration Menu ..................................... 21
   3.4 The Auto Mode Tab ......................................... 25

4 The KD2 Pro Utility .......................................... 27
   4.1 System Requirements ....................................... 27
   4.2 Installation .................................................. 28
   4.3 KD2 Pro Utility Menus ...................................... 28
      4.3.1 Preferences Window .................................. 31
   4.4 Organizing Saved Data ..................................... 35
   4.5 Erasing Your Data .......................................... 36
   4.6 Setting the Date and Time ................................ 37
   4.7 Setting the Auto Mode ..................................... 37

5 Taking Measurements ......................................... 41
   5.1 General Best Practices .................................... 42
   5.2 Measurements in Concrete or Rock ...................... 44
   5.3 Measurements in Insulation ................................ 45
   5.4 Measurements in Liquids ................................... 45
   5.5 Liquid Sample Temperature Control .................... 47

6 Maintenance and Troubleshooting ........................... 49
CONTENTS

6.1 Cleaning and Caring for the Sensors .......................... 49
6.2 Changing the Batteries ........................................... 49
6.3 Verifying Sensor Performance ................................. 50
6.4 Troubleshooting KD2 Pro .......................... 52
6.5 Troubleshooting KD2 Pro Utility Software ............... 52
6.6 Service Instructions ........................................... 53

7 KD2 Pro Theory .................................................. 55
   7.1 Dual Needle Algorithm ...................................... 56
   7.2 Single Needle Algorithm .................................... 57
   7.3 The Error (Err) Value ...................................... 58

8 Reference Materials ............................................. 60

9 Appendix A .......................................................... 62
   9.1 Table of Thermal Units ...................................... 62

10 Appendix B .......................................................... 63
   10.1 Send Feedback to Decagon ................................. 63

11 KD2 Pro CE Compliance ......................................... 65
1 Introduction

Welcome to your new KD2 Pro Thermal Properties Analyzer manufactured by Decagon Devices Inc. This guide should help you understand and use your instrument to the best of its capability.

1.1 About the KD2 Pro

The KD2 Pro is a handheld device used to measure thermal properties. The base KD-2 Pro package consists of a handheld controller and one sensor kit of your choice. There are several sensors available for purchase that operators can insert into almost any material. The single needle sensors measure thermal conductivity and resistivity; while the dual-needle sensor measures thermal conductivity, resistivity, volumetric specific heat capacity and diffusivity. Please read this manual to efficiently and effectively use your KD2 Pro for thermal properties measurements.

1.2 Shipping Contents

KD2 Pro Controller
Carrying Case
USB-to-Serial Cable (3 ft)
“AA” Alkaline Batteries (Four)
Operator’s Manual
KD2 Pro “Read Me First”
Sensor Kit(s) One or more of the sensor kits listed in Table 1.
Table 1: Available Sensor Kits

<table>
<thead>
<tr>
<th>SH-1 Sensor Kit</th>
<th>RK-1 Sensor Kit</th>
<th>TR-1 Sensor Kit</th>
<th>KS-1 Sensor Kit</th>
</tr>
</thead>
<tbody>
<tr>
<td>SH-1 Dual Needle Sensor</td>
<td>RK-1 Single Needle Sensor</td>
<td>TR-1 Single Needle Sensor</td>
<td>KS-1 Single Needle Sensor</td>
</tr>
<tr>
<td>SH-1 Verification Standard</td>
<td>RK-1 Verification Standard</td>
<td>TR-1 Verification Standard</td>
<td>Glycerin Verification Standard</td>
</tr>
<tr>
<td>Dual Needle Spacer</td>
<td>Arctic Alumina Thermal Grease</td>
<td>Arctic Alumina Thermal Grease</td>
<td>Replacement Lid Septums</td>
</tr>
<tr>
<td></td>
<td>SDS Arctic Alumina</td>
<td>SDS Arctic Alumina</td>
<td>SDS Glycerin</td>
</tr>
<tr>
<td></td>
<td>5/32 Roto-Hammer Drill Bits</td>
<td>2.40 mm Drill Bits</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RK-1 Quick Start</td>
<td>Concrete Pilot Pins</td>
<td></td>
</tr>
</tbody>
</table>

Note: You can configure your KD2-Pro with one or a combination of the sensors listed in Table 1.

1.3 Customer Support

If you ever need assistance with your device, have any questions or feedback, there are several ways to contact us. Decagon has Customer Service Representatives available to speak with you Monday through Friday, between 7am and 5pm Pacific time.

Note: If you purchased your sensor through a distributor, please con-
tact them for assistance.

Email: support@decagon.com or sales@decagon.com

Phone: 509-332-5599

Fax: 509-332-5158

If contacting us by email or fax, please include as part of your message your instrument serial number, your name, address, phone, fax number, and a description of your problem or question.

1.4 **Warranty Information**

The KD2 Pro has a 30-day satisfaction guarantee and a one-year warranty.

1.5 **Seller’s Liability**

Seller warrants new equipment of its own manufacture against defective workmanship and materials for a period of one year from the date of receipt of equipment.

*Note: We do not consider the results of ordinary wear and tear, neglect, misuse, or accident as defects.*

The Seller’s liability for defective parts shall in no event exceed the furnishing of replacement parts “freight on board” the factory where originally manufactured. Material and equipment covered hereby which is not manufactured by Seller shall be covered only by the warranty of its manufacturer. Seller shall not be liable to Buyer for loss, damage or injuries to persons (including death), or to property or things of whatsoever kind (including, but not without limitation, loss of anticipated profits), occasioned by or arising out of the instal-
lation, operation, use, misuse, nonuse, repair, or replacement of said material and equipment, or out of the use of any method or process for which the same may be employed. The use of this equipment constitutes Buyer’s acceptance of the terms set forth in this warranty. There are no understandings, representations, or warranties of any kind, express, implied, statutory or otherwise (including, but without limitation, the implied warranties of merchantability and fitness for a particular purpose), not expressly set forth herein.
2 KD2 Pro Overview

The KD2 Pro is a battery-operated, menu-driven device that measures thermal conductivity and resistivity, volumetric specific heat capacity and thermal diffusivity. We designed the KD2 Pro for ease of use and maximum functionality.

2.1 Specifications

Operating Environment

Controller: 0 to 50 °C
Sensors: −50 to +150 °C

Controller

Power: 4 AA batteries
Battery Life: At least 500 readings in constant use or three years with no use (battery drain in sleep mode < 50 uA)
Case Size: 15.5 cm x 9.5 cm x 3.5 cm
Display: 3 cm x 6 cm, 128 x 64 pixel graphics LCD
Keypad: 6 key, sealed membrane
Data Storage: 4,095 measurements in flash memory (both raw and processed data are stored for download)
Interface: 9-pin serial
Read Modes: Manual and Auto Read

Sensors

6 cm (small) single needle (KS-1)

Size: 1.3 mm diameter x 6 cm long
Range:

- 0.02 to 2.00 $\frac{W}{(m \cdot K)}$ (thermal conductivity)
- 50 to 5000 °C $\cdot \frac{cm}{W}$ (thermal resistivity)
Accuracy:

(Conductivity): \( \pm 5\% \) from 0.2 to 2 \( \frac{W}{(m*K)} \) \( \pm 0.01 \frac{W}{(m*K)} \)
from 0.02 to 0.2 \( \frac{W}{(m*K)} \)

Cable length: 0.8 m

10 cm (large) single needle (TR-1)

Size: 2.4 mm diameter x 10 cm long

Range:

\( 0.1 \text{ to } 4.0 \frac{W}{(m*K)} \) (thermal conductivity)
\( 25 \text{ to } 1000 \degree C \times \frac{cm}{W} \) (thermal resistivity)

Accuracy:

(Conductivity): \( \pm 10\% \) from 0.2 to 4.0 \( \frac{W}{(m*K)} \)
\( \pm 0.02 \frac{W}{(m*K)} \) from 0.1 to 0.2 \( \frac{W}{(m*K)} \)

Cable length: 0.8 m

3 cm dual-needle (SH-1)

Size: 1.3 mm diameter x 3 cm long, 6 mm spacing

Range:

\( 0.02 \text{ to } 2.00 \frac{W}{(m*K)} \) (thermal conductivity)
\( 50 \text{ to } 5,000 \degree C \times \frac{cm}{W} \) (thermal resistivity)
\( 0.1 \text{ to } 1.0 \frac{mm^2}{s} \) (diffusivity)
\( 0.5 \text{ to } 4.0 \frac{mJ}{(m^3*K)} \) (volumetric specific heat)

Accuracy:

(Conductivity) \( \pm 10\% \) from 0.2 to 2 \( \frac{W}{(m*K)} \)
\( \pm 0.01 \frac{W}{(m*K)} \) from 0.02 to 0.2 \( \frac{W}{(m*K)} \)
(Diffusivity) \( \pm 10\% \) at conductivities above 0.1 \( \frac{W}{(m*K)} \)
(Volumetric Specific Heat) \( \pm 10\% \) at conductivities above 0.1 \( \frac{W}{(m*K)} \)

Cable length: 0.8 m
6 cm (thick) single needle (RK-1)

*Note: The RK-1 is available for purchase and is not included with standard KD2 Pro.*

**Size:** 3.9 mm diameter x 6 cm long

**Range:**
- 0.10 to 6.00 $\frac{W}{(m\cdot K)}$ (thermal conductivity)
- 17 to 1000 °C * $\frac{cm}{W}$ (thermal resistivity)

**Accuracy (Conductivity):**
- ±10% from 0.2 to 6.0 $\frac{W}{(m\cdot K)}$
- 0.02 $\frac{W}{(m\cdot K)}$ from 0.1 to 0.2 $\frac{W}{(m\cdot K)}$

**Cable length:** 0.8 m
2.2 Keypad Operation

Figure 1: KD2 Pro KeyPad
Power: Activates and deactivates the KD2 Pro.  
*Note: The device automatically turns off if not used for more than ten minutes, except while running in Auto Mode.*

Menu: Cycles between the four menus at the top of the screen.  
*Note: Pressing Menu while changing a setting cancels any operations.*

Arrow Keys: Navigate within menus, sub-menus, and modifies numerical values in sub-menus, as well as selecting different units.  Holding down an arrow key allows you to scroll between different options quickly.

Escape: Backs out of sub-menus and cancels certain actions.

Enter: Makes selections within menus, sub-menus, and also begins taking measurements.

### 2.3 Choosing a Sensor

The KD2 Pro comes with three separate sensors designed for measurements in specific sample types, the KS-1, TR-1, and SH-1. The RK-1 is also available for purchase with your KD2 Pro.

**KS-1**

The small (6 cm long, 1.3 mm diameter) single needle KS-1 sensor measures thermal conductivity and thermal resistivity. We designed the KS-1 for liquid samples and insulating materials (thermal conductivity \(< 0.1W(\frac{W}{m*K})\)). The KS-1 sensor applies a very small amount of heat to the needle which helps to prevent free convection in liquid samples (see Section 5 in this manual regarding measure-
ment in liquid samples for more information). However, the small size of the needle and typically short heating time make the KS-1 a poor choice for granular samples such as soil and powders where contact resistance can be an important source of error. In insulating materials, the errors from contact resistance become negligible making the KS-1 sensor a good choice.

**TR-1**

The large (10 cm long, 2.4 mm diameter) single needle TR-1 sensor measures thermal conductivity and thermal resistivity. We designed the TR-1 primarily for soil, and other granular or porous materials. You can either insert the pilot pin or drill an appropriate sized hole for the TR-1 sensor. The relatively large diameter and typically longer heating time of the TR-1 sensor minimize errors from contact resistance in granular samples or solid samples with pilot holes. The TR-1 needle heats the sample significantly more than the KS-1 sensor, which allows it to measure higher thermal conductivity samples (see earlier specifications). Customers should not measure low viscosity liquid samples with the TR-1 sensor. The 2.4 mm diameter of the TR-1 makes it more robust than the KS-1, meaning that it is less likely to be damaged by normal usage conditions in soil or other solid materials. Additionally, the dimensions of the TR-1 sensor conform to the specifications for the Lab Probe called out by the IEEE 442, “Guide for Soil Thermal Resistivity Measurements,” and ASTM 5334, “Standard Test Method for Determination of Thermal Conductivity of Soiled and Soft Rock by Thermal Needle Probe Procedure.”

*Note: Despite its durability, the TR-1 is a hollow needle that bends with enough applied force. Although the TR-1 comes with drill bits for pilot holes, drilling straight holes in solid materials like rock and concrete is very difficult. Consider using the RK-1 for applications involving solid rock and concrete.*

**SH-1**

The dual needle SH-1 sensor measures volumetric heat capacity, ther-
mal diffusivity, thermal conductivity, and thermal resistivity. The SH-1 is compatible with most solid and granular materials, but operator’s should not use it in liquids due to the large heat pulse and resulting free convection in liquid samples. It is a good fit for foods due to its smaller size.
RK-1

*Note: The RK-1 is optional and not included with the standard KD2 Pro*

The thick (6 cm long, 3.9 mm diameter) single needle RK-1 sensor measures thermal conductivity and thermal resistivity. We designed the RK-1 specifically for use in hard materials like rock or cured concrete, where you must use a rotary hammer to drill a hole to accommodate the sensor. The TR-1 sensor is generally more accurate than the RK-1 sensor and is the preferred choice in granular and solid materials as long as you can make a hole to accommodate the longer and thinner sensor. In instances where the material is too hard to drill a hole for the long, thin TR-1 sensor, a \( \frac{5}{32} \) or 4 mm rotary hammer bit (included in the RK-1 kit) can be used to drill a pilot hole in the material. Make sure to remove any dust or drill cuttings from the rotary hammer hole using a swab or compressed air before inserting the RK-1 sensor. It is also necessary to use the included thermal grease to ensure good thermal contact between the RK-1 sensor and the test material.

*Note: Do not use the RK-1 sensor in liquid samples.*

**Read Time**

The read time is the time, in minutes, the KD2 Pro takes to gather data for computing thermal properties. It applies heat to the sensor for half of the set time, and takes measurements over the full time. The KD2 Pro waits thirty seconds for temperature equilibration before heating starts, so the entire measurement time should be the “Read Time” plus 30 seconds. The sensor takes sixty temperature readings during the read time, so the number entered here also determines the number of seconds between temperature readings. This number displays in the upper right corner of the screen and is available with each data record after downloading. Default read times are one minute for the KS-1 sensor, two minutes for the SH-1 sensor, five minutes for the TR-1 sensor, and ten minutes for the (optional) RK-1 Sensor.
The longer read times for the TR-1 and RK-1 sensors help to prevent errors caused by effects from the large diameter needle and contact resistance between the sensor and the sample in granular and solid materials.

The shorter read time for the KS-1 sensor reduces the amount of heat input into the sample. This is especially important with liquid samples where excessive sample heating can cause errors from free convection (Section 5.4) In low viscosity samples (e.g. water and aqueous solutions), configure the KS-1 read time should be configured to the minimum allowed one minute.

To set the read time, press menu and navigate to the Config menu. Scroll down to Read Time and press Enter. Arrow down to the sensor that you want and press Enter. Then press Enter again to scroll through the read times for that sensor.


### 2.4 KD2 Pro Sensor Compatibility

Table 2: Sensor Use Guide

<table>
<thead>
<tr>
<th>Sample Material</th>
<th>KS-1</th>
<th>TR-1</th>
<th>SH-1</th>
<th>RK-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low viscosity Liquids (Water)</td>
<td>BEST¹</td>
<td>NO</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>High Viscosity Liquids (glycerol, oil)</td>
<td>BEST²</td>
<td>OK²</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>Insulation and Insulating Materials</td>
<td>BEST³</td>
<td>NO</td>
<td>NO</td>
<td>NO</td>
</tr>
<tr>
<td>Moist Soil</td>
<td>NO</td>
<td>BEST</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Dry Soil, Powders, and Granular Materials</td>
<td>NO</td>
<td>BEST⁴</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Concrete and Rock</td>
<td>NO</td>
<td>BEST⁵</td>
<td>OK</td>
<td>BEST⁷</td>
</tr>
<tr>
<td>Other Solids</td>
<td>NO</td>
<td>BEST⁵</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Volumetric Specific Heat</td>
<td>NO</td>
<td>NO</td>
<td>BEST</td>
<td>NO</td>
</tr>
<tr>
<td>Thermal Diffusivity</td>
<td>NO</td>
<td>NO</td>
<td>BEST</td>
<td>NO</td>
</tr>
</tbody>
</table>

¹In low viscosity liquids, set the read time to the minimum allowed one minute and only operate in low power mode to avoid free convection.
²In high viscosity liquids, only use the KS-1 or TR-1 in low power mode.
³The KS-1 in default mode (low power, 1 min read).
⁴In dry granular materials where contact resistance can be significant, extend the read time to the maximum allowed ten minutes to produce the most accurate results.
⁵In solid materials where a pilot hole has been drilled and contact resistance can be significant, use thermal grease and extend the read time to the maximum allowed ten minutes to produce the most accurate results.
⁶The SH-1 sensor takes accurate measurements in rock and cured concrete, but it is very difficult to drill small diameter, parallel holes in these materials to accommodate the SH-1 needles.
⁷The TR-1 is generally more accurate than the RK-1 sensor and should be used if possible. However, it is extremely difficult (or impossible) to drill a long, thin hole into cured concrete and rock samples to accommodate the TR-1. The TR-1 also comes with pilot pins for use in wet concrete or fluidized backfill.
Power Mode

You can configure the KD2 Pro to measure each of the three sensor types in either high power mode or low power mode. In high power mode, the KD2 Pro applies a relatively large heating current to the sensor during a measurement resulting in greater sensor heating. In low power mode, the KD2 Pro applies a small current to the sensor resulting in less heating of the sensor. The KS-1 sensor defaults to low power mode, while the TR-1, SH-1, and RK-1 needles all default to high power mode.

We recommend that only expert operators change the power mode from the default settings for special measurements. In all but a few cases, changing the power mode from the default settings results in reduced accuracy. Feel free to contact Decagon to discuss your specific measurements before changing from the default power mode setting. Pay attention to the following cautions when operating your KD2 Pro.

Caution: Do not attempt to make measurements in liquids with the KS-1 or TR-1 in high power mode. The additional heating from the higher heat input causes free convection and compromise the measurement.

Caution: Do not attempt to make measurements in fluids with the SH-1 (dual needle) or RK-1 sensor.

One motivation behind allowing power mode configuration is to allow the TR-1 and SH-1 sensors to make better measurements in frozen materials where the decreased heat input in low power mode is less likely to cause phase change (melting) of the frozen sample. One situation where we do recommend a non-default power mode setting is the measurement of thermal conductivity of snow. In this case, we recommend using the TR-1 needle to reduce issues with contact resistance, and we recommend configuring the sensor to low power mode to reduce issues with melting.
2.5 Installing the Sensors

We designed all four KD2 Pro sensors for ease of installation and use. Please observe the following considerations when installing the sensors.

- Insert the needle all the way into the material.
- We included a drill bit for the TR-1 sensor that you can use to drill a pilot hole in material such as wood or hard soil. You should use the optional RK-1 sensor for rock (or cured concrete). Drill a $\frac{5}{32}$” or 4 mm hole with a hammer drill and fill it with thermal grease to provide optimal contact between the RK-1 sensor and rock or concrete.
- For the dual-needle sensor, the needles must remain parallel to each other during insertion to make an accurate reading. Therefore, take care in tough material, which can splay the prongs and adversely affect readings. Use the provided red tab with pilot holes to make sure that the needles have the correct spacing. Sample size depends on your sample material thermal properties, contact Decagon for assistance in taking difficult measurements.
- Because the sensors give off a heat pulse, you must allow a minimum of 1.5 cm of material parallel to the sensor in all directions, or errors occur.

*Note: Bending the needles can damage the sensor beyond repair. If the needle becomes bent, do not bend it back; contact Decagon for a replacement.*

- Good thermal contact between the sensors and the measured medium is critical for accurate measurements if you drill a hole for sensor insertion. Make sure that the sensor fits tightly into the hole. Use the thermal grease included with your KD2 Pro to improve contact in drilled holes or grainy samples.
3 The Menus

The KD2 Pro features four main menus: The Main, Data, Config, and Auto. These menus access the KD2 Pro features, and we designed them for ease of use. This section provides a more detailed description of each menu.

3.1 The Main Menu

The Main menu is where you take measurements. The following labeled screen shot shows a breakdown of a typical reading return.

What You See:

1. The thermal property reading and the currently selected unit. The letter to the left of the reading indicates the type of reading.

   - K = thermal conductivity
   - C = specific heat capacity
   - D = thermal diffusivity
   - ρ = thermal resistivity

   Note: When the spinner icon is visible, press the arrow keys to scroll through. The different thermal property readouts for the current sensor.

2. This icon shows the connected sensor type.
3. Indicator for high power mode (HPM) or low power mode (LPM).

4. The currently connected sensor name.

5. The measurement temperature in °C or °F.

6. Indicates the read time selected for current sensor.

7. Indicates that a reading is in progress.

8. Progress bar that displays elapsed time.

The purpose of the Main menu is to take measurements. Section 5 provides more detailed information on how to take a measurement. After taking a measurement, there are three measured values on the left side of the screen.

**Thermal Properties Reading** - The calculated thermal measurement and units reported.

**Starting Temperature** - The initial temperature prior to any heating or cooling.

**Err Value** - The err value is the relative error for the reading. It is a measure of how well the model fits the data (the Theory section of this manual describes the model that is fit to the data). If the model fits the data perfectly, then err = 0.0000. The purpose of displaying this reading is to indicate possible problems with the data. A good data set gives err values below 0.0100, except at very low thermal conductivity (e.g. insulation materials). If the err value is unusually large, discard the data, wait fifteen minutes and take another reading. Review section 7.3 for a detailed explanation of the err value.

On the right side of the screen are three save options:

**Save** - Save your reading as is;

**Annotate** - Attach a sample ID to your reading;

**Discard** - Cancel the current reading and return to the Main screen.

*Note: If the data memory is full or the sample temperature is unstable during a reading, an error message displays at the bottom of the*
screen. If this should happen, you may still take readings but you are unable to save them to the KD2 Pro.

**Annotating Readings:** When you select the “Annotate” option, you see a series of lines with an arrow above and below the first position. Use the up and down arrow keys to select a letter or number and press Enter to move to the next character. If you have annotated a previous reading, the old annotation remains to be modified or deleted.

Repeat the selection process until you reach the last character. When finished, simply continue to press Enter until you reach the end of the row. Holding Enter or Escape allows you to scroll left and right through the Sample ID quickly.

### 3.2 The Data Menu

The Data Menu allows you to view stored data, download data to a computer, and erase the data from your KD2 Pro. It also displays how many readings have been recorded out of the total 4,095 available slots.
View

The View option allows you to view all data currently stored on your KD2 Pro. Press Enter to access the readings, and use the arrow keys to scroll through them. By pressing Enter a second time, you can see more detail about a reading.

Download

The Download feature sends the data saved in the KD2 Pro to your computer. You have two download options:

Download All - This downloads the temperature readings as well as the measured thermal properties.

Download Summary - This downloads just the measured thermal properties.

Note: Your KD2 Pro comes with a USB-to-Serial cable for interfacing with Microsoft Windows. The Utility makes downloading data to your computer very easy.

If you are unable to use the KD2 Pro Utility, you can use the terminal software to transfer the data from your KD2 Pro to your computer. The following steps should apply to most terminal software programs.

1. Configure your terminal software with the following settings.
   - 9600 baud
• 8 data bits, 1 stop bit, no parity
• No software or hardware flow control
• Append line feeds to incoming line ends
• Echo typed characters locally.

2. Connect your KD2 Pro to an available USB port on your computer using the included USB-to-Serial cable.

3. Set your terminal software to capture received data if you want to save the data.

Erase

This erases all stored data on your KD2 Pro.

Caution: This feature completely erases all data on your KD2 Pro, and once activated, it cannot be undone.

Follow steps 1 through 3 to erase data.

1. Press Enter to select Erase. The screen “Erase all stored data?” appears.

2. Press Enter again to erase the memory or Escape if you decide not to continue. “Erasing...” displays as the device deletes, which usually takes about six seconds.

3. When this is complete, the controller returns to the Data Menu.

3.3 The Configuration Menu

The Configuration Menu allows you to change system settings and view information about your KD2 Pro. A battery icon here also displays the remaining percentage of battery power. There are seven main customizable features of the “Config” menu: Date, Time, Units, Read Time, Power Mode, Contrast and the About feature.
Date

Follow steps 1 through 5 to change the current date.

1. Press Enter to select the date display.

2. The date appears in the center of the screen in day/month/year format. A pair of arrows are present above and below the first number.

3. Use the up and down arrow keys to change this number.

4. Press Enter to move to the next item, and repeat step #3. If you need to return to the previous number, press Escape.

5. When you have finished changing the last number, press Enter to return to the Configuration Menu.

Time
Press Enter to select the Time display and follow the same procedures as setting the date.

**Units**

You can choose to represent measurement data in either SI or English units. Press Enter to select an option.

**Table 3: SI and English Unit Equivalents**

<table>
<thead>
<tr>
<th></th>
<th>Thermal Conductivity (K)</th>
<th>Thermal Resistivity (ρ)</th>
<th>Volumetric Specific Heat (°C)</th>
<th>Thermal Diffusivity (D)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SI</strong></td>
<td>$\frac{W}{(m*K)}$</td>
<td>$\frac{°C*cm}{W}$</td>
<td>$\frac{MJ}{(m^3*K)}$</td>
<td>$\frac{mm^2}{s}$</td>
</tr>
<tr>
<td><strong>English</strong></td>
<td>$\frac{BTU}{hr<em>ft</em>°F}$</td>
<td>$\frac{hr<em>ft</em>°F}{BTU}$</td>
<td>$\frac{BTU}{°F*ft^3}$</td>
<td>$\frac{ft^2}{hr}$</td>
</tr>
</tbody>
</table>

**Note:** Readings in watts per meters Celsius ($\frac{W}{m}*°C$) are the same as readings in watts per meters Kelvin ($\frac{W}{m}*K$), as Celsius and Kelvin degrees are on the same temperature scale.

**Read Time**

Allows you to change the read time duration for each sensor type. To change the read time select the sensor, press Enter, and scroll through the read time options. Press Esc or Menu to accept the changes and exit the Power Mode menu. For information on which read time to use refer to Section 2.
Power Mode

Allows you to change the power mode each sensor type uses. Do not change the power mode from the default settings unless you are an expert operator and are making a specialized measurement. To change the power mode, select the sensor and press enter to toggle between high and low power mode. Press Esc or Menu to accept the changes and exit the Power Mode menu. For more information on situations where you might want to change from the default power mode, see the Power Mode portion of Section 2.4.

Contrast

Allows you to change the screen contrast level. Press Enter and follow the on-screen instructions to modify the contrast.
About

Displays the serial number and firmware version of your KD2 Pro.

3.4 The Auto Mode Tab

The Auto Mode allows you to set up the KD2 Pro to take readings automatically. You can select a measurement time in intervals of 15 minutes. The KD2 Pro takes the reading at the selected interval, in the currently selected units from the Main menu, and begins as soon as you select this option.

*Note:* Should the KD2 Pro data memory ever become full (4,095 readings), you may still take readings, but you cannot save them until you erase the stored readings.
Reading Return Screen Shot Labels

1. Final measurement displayed in the selected units.
2. Icon showing connected sensor type.
3. Indicator for high power mode (HPM) or low power mode (LPM).
4. Currently connected sensor type.
5. Measurement temperature in °C or °F.
6. Indicates the selected read time.
7. Set the Measurement interval using the up and down arrows when an hour glass is on the screen.
8. Hourglass icon indicating that time is elapsing until the next measurement.
9. Number of readings taken.
10. The err value of your data (see description of err value in the “Main menu” portion of this section for more details).

Note: The KD2 Pro Utility gives you more options to control how Auto Mode operates, including different time intervals, delayed start times, and others.
4 The KD2 Pro Utility

Figure 2: KD2 Pro Utility Main Screen

The KD2 Pro Utility is a program designed specifically for interfacing with the KD2 Pro. Use this program to download measurement data to your computer, erase measurement data stored in the KD2 Pro, set the date and time, configure the KD2 Pro to take readings automatically, and see information about your KD2 Pro.

4.1 System Requirements

Your computer must meet several minimum system requirements to use the KD2 Pro Utility.

- Microsoft Windows 98 or NT 4 (SP 5) or better
- Intel Pentium Pro or better processor
• One available USB or serial port port (most models of USB-to-serial adapters supported)
• Microsoft Excel 97 or better (for saving data as .xls files)

4.2 Installation

You can install the KD2 Pro Utility using the included USB drive (found in the inside cover of the KD2 Pro Operator’s Manual). You may also download and install the latest version of the Utility in the Support section of the online KD2 Product page at www.decagon.com/thermal.

The KD2 Pro Utility features four main menus, the File, Edit, Actions, and Help menus. These allow you to change program settings, as well as settings on the KD2 Pro.

4.3 KD2 Pro Utility Menus

File Menu

Download Summary Data: Using this menu option or the download button on the Main screen allows the user to download all data except heating and cooling cycle temperature readings.

Download All Data: This allows for the download of all data, including heating and cooling cycle temperature data stored on the KD2 Pro.

Downloading Data:

This copies all saved measurement data on the KD2 Pro to your computer. Follow steps 1 through 5 to download all measurements on the KD2 Pro to your computer.

1. Make sure the USB-to-Serial cable connects to the KD2 Pro and to a USB port on your computer.
2. Open the KD2 Pro Utility.
3. If the correct port is not automatically chosen, select the appropriate serial communication (COM) port from the “Use computer communication port” control on the Main screen.

4. Click the “Download” button in the lower right-hand corner to download all summary day. You can also go to the File menu, and select one of two options:
   
   (a) Download Summary Data - Downloads and summarizes the data readings, but does not display per-second readings.
   
   (b) Download All Data - Downloads all data currently stored in the KD2 Pro memory. It displays complete data for each measurement, including per-second readings.

If you encounter an error message after clicking this button, please refer to Section 6 Troubleshooting section for instructions. Name your data file, select where it saves to, and in what format. You may choose from four file formats.

   (a) Microsoft Excel Workbook (*.xls)
   (b) Comma delimited (*.csv)
   (c) Tab delimited (*.txt)
   (d) Raw data (also *.txt)

5. Click “Save” to download your data to the specified location. The progress bar shows the status of the download process. (Figure 3)
Figure 3: KD2 Pro Downloading Data

Note: You can cancel a download in progress using the cancel button. If you cancel, it does not save any downloaded data.

Erase Data Removes all data from the KD2 Pro. This is an irreversible function.

Edit Menu

The Edit menu contains the cut, copy, paste, preferences, and select all features. The important feature here is the Preferences window. The Preferences window allows you to modify program and communication settings for the KD2 Pro. The Preferences window has three tabs: the Data File, Communications, and Application tabs.
4.3.1 Preferences Window

Data File Tab

Figure 4: Preferences Menu – Data File Tab

The data file has several features.

**Measurement Units:** Selecting “Use KD2 Pro Settings,” saves all downloading measurement data in the units used on the KD2 Pro. You can also choose to override the settings in the KD2 Pro and save your measurement data using either SI (metric) or English units.

**Column Headers:** This option allows you to include or exclude column headers (i.e. “Measurement Time,” “Sample ID,” etc.) for downloaded data. The “Raw Data” files do not have headers.

**Date/Time Format:** Sets the date and time format for down-
loaded data files. You can select to use “Windows Regional and Language Options,” 24-hour time, or 12-hour time.

Communications Tab

![Preferences Menu – Communications Tab](image)

**Figure 5: Preferences Menu – Communications Tab**

**Command Retries:** If you encounter difficulty communicating with your KD2 Pro, you can set the number of times the computer should automatically try sending communications commands again (up to ten times).

**Maximum Baud Rate:** You can set the maximum baud rate for talking to your KD2 Pro. Choose a lower baud rate if you are not getting reliable communications from your device.

**Force Find all Communications Ports:** This detects all COM ports on your computer, and should be used if your USB-to-Serial adapter does not appear in the “Use computer communication port” option.
control.

**Application Tab**

![Preferences Menu – Application Tab](image)

**Figure 6: Preferences Menu – Application Tab**

**Automatic Internet Version Checks:** If you select this option, the KD2 Pro Utility automatically checks for a newer version using Decagon’s Internet version check engine. It notifies you when a newer version is available when your computer is connected to the Internet. You can turn off the automatic check by unchecking this option. You can manually check for updates anytime using the “Check for Utility Updates...” option in the Help menu.

**Automatic Clock Synchronization:** Automatically sets the KD2 Pro time to your computer time, when you are connected to it. (See instructions for setting this manually later in section 4)
Actions Menu

**Set KD2 Pro Date/Time:** See “Setting Date and Time” portion of this section for more information on setting the date and time.

**Configure Auto Mode:** Allows you customize how the KD2 Pro operates in Auto mode. You can program specific time intervals and start times in this menu. See “Setting the Auto Mode” in Section 4 for more information.

**View KD2 Pro Information:** Displays information about your KD2 Pro. See “Viewing KD2 Pro Information” section for more information.

Help Menu

The Help menu allows accesses the KD2 Pro Utility help file, which provides detailed information on how to use the program.

**Send Feedback to Decagon:** This menu item helps you send product feedback, bug reports, or feature requests to Decagon. Your computer must be connected to the Internet for this feature to work. See Appendix B for more information.

**Check for Utility Updates:** If you select this function when connected to the Internet, the KD2 Pro Utility checks for a newer version using Decagon’s Internet version check engine. It notifies you if a newer version is available.

**Check for Firmware Updates:** If you select this function when connected to the Internet and your KD2 Pro, the KD2 Pro Utility checks for updates for the KD2 Pro operating system (firmware).

**About KD2 Pro Utility:** Displays the current program version and Decagon contact information.
4.4 Organizing Saved Data

Measurement Data from the KD2 Pro saves in the same basic structure regardless of the file format chosen. You can choose to download summary data or all measurement data. A description of each type of download follows.

Clicking the Download button or choosing “Download Summary Data” from the File menu creates a file with the following columns:

- **Measurement Time** - Shows date and time of the reading.
- **Sensor** - The model number of the sensor used for this reading.
- **K (Thermal Conductivity)** - as \( \frac{W}{(m \cdot K)} \) or \( \frac{BTU}{(hr \cdot ft \cdot ^\circ F)} \).
- **\( \rho \) (Thermal Resistivity)** - as °C \( \cdot \frac{cm}{W} \) or \( \frac{hr \cdot ft \cdot ^\circ F}{BTU} \).
- **°C (Specific Heat)** - as \( \frac{MJ}{(m^3 \cdot K)} \) or \( \frac{BTU}{(°F \cdot ft^3)} \).
- **D (Thermal Diffusivity)** - as \( \frac{mm^2}{s} \) or \( \frac{ft^2}{hr} \) (dual-needle sensors only).

Note: Columns for Specific Heat and Thermal Diffusivity are only included when the downloaded data contains measurements made with SH-1.

- **Err** - Quality of fit of the data to the KD2 Pro theoretical model.
- **Temp(0)** - Initial temperature of the sample as °C or °F.
- **Sample ID** - If saved with the measurement.
- **Read Time** - as minutes from the start of heating. The interval between readings is also Read Time (in sec).
- **Power Mode** - Power mode selected during measurement.

Choosing “Download All Data” from the File menu creates a file with all the data included in the summary file (listed above) and adds the following columns:
• Power - as \( \frac{W}{m} \)
• Current - as amps

The next 60 columns in the row hold the individual temperature reading the KD2 Pro uses to calculate the thermal properties of the sample. The data displays in either °C or °F.

The time interval between the 60 individual temperature readings is scaled according to the read time selected. For instance, if a one minute read time has been selected, each of the 60 temperature readings are at one second intervals, while a five minute read time produces 60 temperature readings at five second intervals, etc.

The KD2 Pro Utility formats measurement dates according to the Windows Local settings found in the Control Panel under “Regional and Language Options” (“Regional Settings” in Windows 98). You can override this by going to the Preferences Menu > Data File tab, and selecting an option under “Date/Time Format.” You can set this value to day/month/year format, using a 12- or 24-hour clock. (The Preferences Menu is explained in more detail later in this section.)

4.5 Erasing Your Data

This erases all data stored on your KD2 Pro.

Caution: Once you activate this feature, all data is permanently deleted from the KD2 Pro and cannot be recovered.

Follow steps 1 through 4 to erase the data.

1. Make sure that the USB-to-Serial cable connects securely to the KD2 Pro, and to a USB port on your computer.

2. If the correct port is not automatically chosen, select the appropriate serial communication (COM) port from the “Use computer communication port” control on the Main screen.

3. Click “Erase,” in the lower left hand corner, or select “Erase Data...” from the File menu.
Note: If you encounter an error message, please refer to the Troubleshooting section for instructions.

4. A progress bar shows the status of the erase process.

4.6 Setting the Date and Time

You can set the KD2 Pro date and time by selecting “Set KD2 Pro Date/Time...” from the Actions Menu. This automatically syncs the KD2 Pro date and time to your computer time.

4.7 Setting the Auto Mode

The Auto mode of the KD2 Pro allows you to perform automatic and autonomous measurements at specified time intervals. The KD2 Pro has pre-set measurement intervals to select for this mode, but you can better customize how the KD2 Pro operates in Auto mode using the KD2 Pro Utility software. For example, you can select specific measurement intervals, delayed start times, and the number of measurements from this menu.

Follow steps 1 through 3 to configure Auto Mode with the KD2 Pro Utility.

1. If the correct port is not automatically chosen, select the appropriate serial communication (COM) port from the “Use computer communication port” control on the Main screen.

2. Choose “Configure Auto Mode...” from the Actions Menu. The Configure Auto Mode screen appears.
3. Choose values for Measurement Interval, Start Time, and Number of Measurements. Each of these values is explained below.

**Measurement Interval:** The Measurement Interval is the time interval (in minutes) that the KD2 Pro waits between measurements. The instrument must have a minimum of 15 minutes between measurements to allow for thermal gradients to dissipate. Therefore, you can select any number over 15 minutes, up to 1,440 minutes (24 hours).

**Start Time:** Allows you to select when the auto measurement begins. Choose start times ranging from “Start Now” to delaying the start for 24 hours. If you select “Start Now,” make sure you have the needle in the sample and thermally equilibrate because you have only 30 seconds to connect the thermal properties sensor to the KD2 Pro before the reading starts.
Number of Measurements: This is the total number of measurements that you want the KD2 Pro to make while in Auto Mode. The number is between one and the amount of available memory. As you change this value, the Experiment Duration value changes. The KD2 pro stores up to 4,095 readings.

Experiment Duration: This is the total amount of time that your KD2 Pro operates in Auto Mode, according to your measurement interval and number of measurements selected. This gives you an idea of how long the total Auto Mode experiment time takes.

Available Memory: This shows how much memory you have available for storing measurements. The KD2 Pro Utility prevents you from defining an experiment that could exceed the amount of available memory. If you reach the limit of memory storage, the KD2 Pro stops taking measurements in Auto Mode.

KD2 Pro Date/Time: This shows the current time in your KD2 Pro. If the time is not correct, click the Cancel button, then choose “Set KD2 Pro Date/Time...” from the Actions Menu.

4. Click on the Start button. The KD2 Pro Utility then sends your settings to the KD2 Pro.

5. Unplug the cable from the KD2 Pro, then connect the desired thermal properties sensor to the instrument. Your KD2 Pro is now ready to make autonomous measurements as you have programmed it.

Viewing KD2 Pro Information

Choose “View KD2 Pro Information...” from the Actions Menu to see information about your KD2 Pro.
This displays useful info about your KD2 Pro, including its serial number, firmware version and status, battery status, the number of currently stored measurements, and current data and time in the KD2 Pro operating system.
5 Taking Measurements

Making thermal measurements with the KD2 Pro. Section 5 helps you get accurate measurements.

*Note: If the temperature of the sample is different from the temperature of the needle, the needle must equilibrate to the surrounding temperature before beginning a reading.*

1. Attach appropriate sensor then turn on the KD2 Pro.

2. Properly insert the needle into the material to be measured. (See “Installing the sensors” in this section for instructions.)

3. When the KD2 Pro turns on, you should be in the Main menu. (Figure 2) If not, press the Menu key until you arrive there. Press Enter to begin the measurement.

4. An icon appears on the left and right side of the screen. The icon at left indicates the type of sensor connected. The circular icon indicates that a reading is in process. It changes to a thermometer icon to indicate whether the measurement is currently in heating or cooling mode; when the thermometer is rising, heat is applied to the needle, and when it is falling, heat is off. A progress bar at the bottom of the screen shows the elapsed time.

5. When the reading is complete, the results display as follows.

```
MAIN | DATA | CONFIG | AUTO

0.122 \( \frac{W}{\text{mk}} \)  \( \bigcirc \) Save

34.0°C  \( \bigcirc \) Annotate

err = 0.0016  \( \bigcirc \) Discard

Record 2 of 4095
```
5 TAKING MEASUREMENTS

Note: It is important to allow about fifteen minutes for equilibration between readings, even if the sensor is left in the same location.

If multiple measurements of a sample are made too rapidly in succession, the sample and needle temperature do not have had enough time to equilibrate from the previous reading, and the resulting measurement is inaccurate. For best results, the sample should be as close to equilibrium as possible. You can provide a good environment for equilibration by placing the KD2 Pro sensor and sample in an isothermal chamber or Styrofoam box.

5.1 General Best Practices

The quality of the measurements you get with the KD2 Pro can be strongly affected by your measurement practices. The following suggestions can help you to recognize and avoid pitfalls in data collection so that you obtain the most accurate data possible.

1. Keep the temperature of the sample as constant as possible during the measurement. The measurement is made by heating a needle that is placed in the sample and monitoring the temperature of the needle. In the case of the SH-1 sensor, one needle heats while the other one monitors. The heat input is made as small as possible to avoid thermally driven redistribution of moisture in the sample. The temperature change from heating may therefore be only a few tenths of a degree.

Sample temperature changes during the measurement period degrade the data and make it difficult for the inverse calculation to find the correct values for the thermal properties. The algorithms in the KD2 Pro are several orders of magnitude less sensitive to these errors than the conventional approach (plotting temperature vs. log time during heating and looking for a linear portion of the graph) but there can still be errors if the temperature changes too rapidly during a measurement. To minimize these sources of error:

(a) First, always allow about 15 minutes for samples and needles to equilibrate with the ambient temperature before
taking measurements.

(b) Allow around 15 minutes between readings for temperatures to equilibrate.

(c) If measurements are made in a temperature chamber or water bath, make sure the sample temperature stays relatively constant before the measurement starts. Measurements made while a sample taken from an oven and cooling to room temperature can show significant errors if the cool rate is too fast. Measurements made while the sample is undergoing heating or cooling return large errors and are less accurate than samples with a stable temperature.

(d) When measuring thermal properties in the field, allow fifteen minutes or so after sensor insertion for temperature equilibration.

2. Minimize contact resistance. In granular materials, or in solids where a hole has been drilled to accommodate the sensor, there is an additional thermal resistance between the heated sensor and the material into which the sensor is inserted. This extra resistance is called contact resistance, and it decreases the thermal conductivity value registered by the sensor. This effect can be minimized by applying thermal grease to the sensor prior to inserting it as described in the Decagon Application Note “Reducing Contact Resistance Errors in KD2 Thermal Properties Measurements” located in the Support section of https://www.decagon.com/thermal. When you drill a hole for the sensor, make sure the sensor fits in the hole is as tight as possible. Inject thermal grease onto the needle as needed to improve contact.

Long read times also decrease the effect of contact resistance. If you are measuring a sample that might give errors from contact resistance, increase the read time from the default to the maximum (10 minutes) for most accurate results.

Finally, the TR-1 works best for dry granular materials and powders that have large contact resistance, try to always use
the TR-1 sensor in these types of materials.

3. Do not bend the needles. Needle spacing on the SH-1 sensor is critical for accurate measurements. A 1% change in needle spacing results in a 2% error in measurement of diffusivity and specific heat. A guide is provided for maintaining proper needle spacing during insertion of the sensor into a sample. The Delrin verification block included with your system shows the correct sensor spacing. If a needle is slightly bent, it can be carefully straightened until the tip spacing matches the hole spacing in the calibration block.

## 5.2 Measurements in Concrete or Rock

The best method of using the KD2 Pro for measurements in concrete or Fluidized Thermal Backfill™ is to mold pilot holes in wet concrete using the pilot pins furnished with your KD2 Pro. Follow these four steps to install the pilot pin.

1. Coat pilot pin with thermal grease or Vaseline.
2. Install pin at least 10 cm deep while concrete is wet. Do not bury the pin or it becomes hard to grip for removal.
3. Remove pin when concrete dries.
4. Coat the TR-1 sensor with thermal grease, insert sensor into the cast hole and begin to take readings.

If you need to take measurements in rock samples or cured concrete, use the optional RK-1 sensor. The RK-1 sensor kit includes a “5/32” rotary hammer bit to drill pilot holes that accommodate the RK-1 sensor. (4 mm rotary hammer bits are also acceptable). After drilling the holes, be sure to clean the dust and drill cuttings from the rotary hammer hole using a swab or compressed air before inserting the RK-1 sensor. It is also necessary to apply a liberal coat of the thermal grease on the needle to ensure good thermal contact between the RK-1 sensor and the test material.
5.3 Measurements in Insulation

KS-1 Insulation measurements are best taken using a ten minute read time. The long read time minimizes contact resistance errors, and the low heat of the KS-1 needle reduces free convection errors. Always drill a hole in foam insulation for the sensor. Manually pushing in the needle can cause the insulation to bunch in front of and around the needle resulting in a poor fit and a consequently a faulty reading. In fiber type insulation materials, assure that the insulating materials are not unduly disturbed by the needle insertion. (i.e. pushed in front of the needle tip). Do not allow the sensor to move during the measurement.

5.4 Measurements in Liquids

We designed the KS-1 sensor to measure thermal conductivity and resistivity of liquid samples. However, measuring thermal properties of liquids is difficult and great care must be taken to obtain accurate and repeatable results. For an accurate measurement of thermal properties of a liquid sample, the sample must be absolutely still in relation to the KS-1 sensor. Convection, or bulk movement of the sample, causes errors in the thermal properties measurement. Error from convective heat exchange is often very large, rendering the thermal properties measurement useless.

Note: We did not design the TR-1 and SH-1 sensors for thermal properties measurement in liquids. They do not return accurate results in those materials.

Convective heat exchange in fluids can be broken down into two categories: forced and free convection. Forced convection occurs when the fluid is agitated or mixed by mechanical forces. Free convection may occur when a body of higher or lower temperature is present in a fluid. The temperature difference between the body and fluid creates density gradients in the fluid, and these density gradients cause the fluid to mix. From a practical standpoint certain steps can be taken to minimize both forced and free convective heat exchange.
To eliminate forced convection, the fluid sample and the sensor must be absolutely still during the measurement. Even minute vibrations in the sample are often enough to compromise the thermal properties measurement. Some common sources of vibrations found in the laboratory that have been shown to affect thermal properties measurement in liquids and must be avoided include:

- HVAC (Heating, Ventilating, and Air Conditioning) systems
- Computer fans that are near the measurement apparatus
- People moving around the lab
- Other laboratory equipment

If sources of vibration are present in laboratory, it may be necessary to place the sample on a vibration isolation table to prevent errors from convection. Another common strategy is to configure the KD2 Pro in auto mode and make measurements overnight after turning off the HVAC system and any other lab equipment that might cause vibrations.

The KD2 Pro KS-1 sensor is specially designed to add a very small amount of heat to the sample during measurement and thereby minimize problems with free convection. In high viscosity liquids (e.g. oils, glycerin), free convection is generally not an issue. However, in low viscosity liquids like water or aqueous solutions, there are several important tips to aid you in obtaining accurate measurements.

- When dealing with low viscosity liquid samples, the duration of the read time should be as small as possible to minimize the amount of heat added to the sample.
- The default read time for the KS-1 sensor is one minute. If you are measuring in low viscosity liquids, use this read time.
- In liquid samples, the KS-1 sensor needle should be oriented vertically during the measurement to help prevent free convection.
- Never use the KS-1 sensor in high power mode in liquids. The sensor must be configured in low power mode to prevent free convection.
5.5 Liquid Sample Temperature Control

Often it is desirable to control the temperature of the liquid sample above or below ambient temperature during thermal properties measurement. It is important that the act of heating or cooling the sample does not cause forced or free convection as mentioned above. There are several things that should be avoided when measuring thermal properties of heated or cooled samples. **Cautions:**

Do not heat the sample from the bottom (e.g. on a hot plate). The temperature gradient from the heating causes free convection.

Do not make measurements in a conventional refrigerator or freezer. Conventional cooling devices have very large cyclical temperature cycles which can cause excessive sample temperature drift and poor measurements. Vibrations from the compressor also causes forced convection in the sample.

Do not measure the thermal properties of the sample while it is in a circulating water bath. The vibrations from the water bath pump and from the circulating water causes forced convection in the sample.

**Controlling Temperature**

Several researchers who use the KD2 Pro with liquid samples suggest the following three steps as the best method for controlling the temperature of liquid samples.

1. Heat or cool the sample (with sensor inserted) in a water bath.
2. Once the sample temperature has equilibrated to the desired water bath temperature, turn the water bath off.
3. Allow enough time for the water bath to become absolutely still, and make the measurement.

*Note: Experimental results from researchers have shown that the*
KD2 Pro KS-1 sensor can make accurate measurements in water and aqueous solutions up to about 50 °C. Above this temperature, the viscosity of the water becomes too low and free convection begins to affect the measurement.

For a more in-depth discussion of measuring thermal properties of liquids, download the Application Note or watch the video on this at www.decagon.com/thermal under the Support tab.
6 Maintenance and Troubleshooting

Although Decagon built the KD2 Pro according to the highest quality standards, you must practice proper care and maintenance to ensure continuing operation.

6.1 Cleaning and Caring for the Sensors

The sensors are stainless steel, so they are easy to clean, though some materials corrode stainless steel. Be sure to carefully clean the needle after removal from sample materials. When they need cleaning, just wipe them with a damp cloth. Take care never to bend or move the needles. If the needle becomes bent, it is most likely broken and requires testing and replacement. Contact Decagon to see if a replacement sensor is necessary.

6.2 Changing the Batteries

Although we designed the KD2 Pro to provide an excellent battery lifespan, the batteries eventually requires changing. When this happens, a low-battery indicator appears in the upper left hand corner of the screen. The KD2 Pro requires four alkaline “AA” batteries. Follow steps 1 through 4 to change the batteries.

1. Turn over the KD2 Pro and locate the battery cover.

2. Place your thumb on the grooves and pull away from the controller to loosen the cover.

3. Remove the old batteries and insert new ones. Be sure to orient the fresh batteries according to the polarity marks shown in the case.

4. Update the time and date either in the Config menu of the KD2 Pro, or by using the KD2 Pro Utility.
6.3 Verifying Sensor Performance

The KD2 Pro ships with three standard materials you can use to verify that the sensors are operating according to specifications. These three materials are a clear vial of glycerin (glycerol) for the KS-1 Sensor, a white plastic cylinder for the SH-1 needle sensor, and a TR-1 Verification Standard for the TR-1 and RK-1 single needle sensors.

Use the glycerol to verify KS-1 Sensor performance. The cap of the vial has a septum that allows direct insertion of the needle into the vial for verification.

Note: After repeated use the septum may begin to leak. We provide replacement septums with your instrument. To replace simply remove the cap, press the old septum out and replace with a new one.

To conduct a performance verification, insert the needle fully into the glycerol. Orient the needle vertically and turn the vial of glycerol upside-down on top of the needle. Holding the vial upside down ensures that any bubbles in the glycerol float to the top away from the needle. Center the needle in the vial, without touching any side of the vial. Before taking a measurement in the glycerol, make sure that the system is not undergoing rapid temperature drift. Even the heat from holding the vial in your hand for a few seconds, or the cooling from direct air conditioning flow can decrease the accuracy of the measurement. (Section 5.4 details the best practices for measuring liquids.) It is best to place the needle and vial in an isothermal environment (e.g. insulated chamber or cooler), and allow 15 minutes of equilibration time before taking the measurement. The thermal conductivity of the glycerol is $0.285 \frac{W}{(m*K)}$ at $20 \degree C$.

Use the two-hole Delrin block to verify the performance of the dual-needle (SH-1) sensor. Fully insert the SH-1 sensor into the pre-drilled holes in the Delrin and allow it to equilibrate for at least 15 minutes before taking the measurement. Make sure that the system is not undergoing rapid temperature drift. Slight temperature differences from sources like body heat or AC can decrease the accuracy of the measurement. It is best to place the needle and block in an isother-
mal environment (e.g. insulated chamber or cooler), and allow 15 minutes of equilibration time before taking the measurement. The Delrin blocks have slightly different thermal conductivities from lot to lot, so we record the correct values for $K$, $C$, and $D$ for your individual Delrin block are recorded on your Certificate of Quality Assurance. Your readings should be within 10% of the values on the certificate.

Verification for the TR-1 and optional RK-1 is similar to that for the SH-1. Place the needle in the block, wait fifteen minutes, taking care to minimize temperature disturbances, and then take a reading. The reading of the value recorded on your Certificate of Quality Assurance be within 10%.

At the request of multiple KD2 Pro operators, we have characterized the temperature dependence of the thermal conductivity of the TR-1 and RK-1 verification cylinders. We collected measurements on three black plastic cylinders from different lots of material over the temperature range of $-20$ to $60$ °C (Figure 9). We found little temperature dependence on any of the samples with maximum differences over the $-20$ to $60$ °C range. The difference is never greater than $0.004 \ \text{W/mK} \ (\sim 1\%)$. Figure 9 shows a graphical representation of these values.

![Figure 9: Thermal Conductivity as a Function of Temperature. Error bars represent ±1 standard deviation in five replicated measurements.](image)
6.4 Troubleshooting KD2 Pro

If you encounter problems with your KD2 Pro, refer to the following items to see if they resolve your problem.

1. PROBLEM:
I am getting poor or inconsistent readings.

SOLUTION:

Conduct a verification of the sensor to ensure it is operating within specifications. Refer to Section 5 for measurement procedures and guidelines.

2. PROBLEM:
The KD2 Pro says it does not recognize the connected sensor.

SOLUTION:

Make sure the connection between the sensor and the KD2 Pro is secure, and that none of the connector pins are bent or broken off. If the KD2 Pro still fails to recognize the sensor, the sensor may be malfunctioning. Contact Decagon for more assistance.

6.5 Troubleshooting KD2 Pro Utility Software

The following descriptions should help you if you encounter any difficulty using the KD2 Pro Utility.

1. PROBLEM:
The KD2 Pro Utility tells me another application is using the COM port, but I do not think any other programs are running.

SOLUTION:

Some PDA synchronization software monitors serial communication ports. Disable Microsoft’s ActiveSync or Palm’s HotSync system software while using the serial port with the KD2 Pro Utility.
2. PROBLEM:
My USB-to-Serial adapter is not showing in the communication port picker.

SOLUTION

Enable “Force find all Communication Ports” in Preferences by going to the Edit > Preferences, and then selecting the Communication tab. Enable the check box at the bottom of the screen. Enabling this option may find other serial ports that are not available for use by the KD2 Pro Utility (for example, modems installed in your computer).

3. PROBLEM:
Downloading data stops in the middle with an error message saying the Utility lost connection with the KD2 Pro.

SOLUTION

A noisy serial connection can disrupt the connection between the Utility and the KD2 Pro. If this error happens regularly, you can try setting your baud rate lower or increasing the number of times you send a command to the KD2 Pro. Choose the Communications tab in Preferences to alter this setting.

6.6 Service Instructions

If your KD2 Pro should ever require servicing, call Decagon at 509-332-5599. We ask you for your address, phone number, your KD2 Pro serial number, and your current firmware version. For non-warranty repairs, we also ask for a method of payment.

Before shipping your instrument to Decagon, please contact us to obtain a Request Maintenance Authorization number (RMA). This allows our repair staff to keep track of your KD2 Pro. Once you have acquired an RMA, send your KD2 Pro to Decagon.
Please pack your KD2 Pro carefully. Ship it back in the carrying case, preferably inside a cardboard box. Ship to:

**Decagon Devices Inc.**  
2365 NE Hopkins Court  
Pullman, WA 99163  
ATTN: RMA[RMA Number]

**Repair Costs**

Decagon repairs manufacturer’s defects and instruments under warranty at no cost. We bill costs for parts, labor, and shipping for non-warranty repairs,.
7 KD2 Pro Theory

Researchers have used transient line heat source methods to measure thermal conductivity of porous materials for over 50 years. Typically a probe for this measurement consists of a needle with a heater and temperature sensor inside. A current passes through the heater and the system monitors the temperature of the sensor over time. Analysis of the sensor temperature determines thermal conductivity. More recently the heater and temperature sensors have been placed in separate needles. In the dual probe the analysis of the temperature vs time relationship for the separated probes yields information on diffusivity and heat capacity as well as conductivity.

An ideal sensor has very small diameter and a length perhaps 100 times its diameter. It would be in intimate contact with the surrounding material and would measure the temperature of the material during heating and cooling. Ideally, the temperature and composition of the material in question would not change during the measurement.

Real sensors fall short of these ideals in several ways. A sensor small enough to be ideal would be too fragile for most applications. Measurements in outdoor environments involve changing temperatures; the ambient temperature generally is not constant. Heating moist, unsaturated soil causes water to move away from the heat source, thus altering the water content in the region of measurement, and the hole made for the probe often disturbs the material around it causing a contact resistance between the sensor and the material.

It is a challenge to design a sensor that gives accurate measurements under all conditions. If the sensor is too small it is fragile, and the contact resistance can be high in dry, porous materials. Large sensors require a long heating time, but the long heating time drives water away from the sensor and can cause free convection in liquid samples, thus altering the reading. A high heating rate makes temperature changes easier to read and less susceptible to temperature drift errors, but results in water movement out of the measuring region and free convection in liquids. We recommend long heating times to min-
imize contact resistance that results in water movement away from the sensor.

Decagon’s KD2 Pro design attempts to optimize thermal properties measurements relative to these issues. Our sensors are relatively large and robust making them easy to use. The KD2 Pro keeps heating times as short as possible to minimize thermally induced water movement and lower the time required for a measurement. We also limit heat input to minimize water movement and free convection. Use of relatively short heating times and low heating rates requires high resolution temperature measurements and special algorithms to measure thermal properties. The KD2 Pro resolves temperature to $\pm 0.001 \, ^\circ C$ in temperature. It uses special algorithms to analyze measurements made during a heating and a cooling interval. Algorithms also separate out the effects of the heat pulse from ambient temperature changes. The KD2 Pro uses two different algorithms, one for the dual needle sensor and one for the single needle, based on Carslaw, Jager, and Kluitenberg’s line heat source analysis.\(^8\)

### 7.1 Dual Needle Algorithm

Heat is applied to the heated needle for a set heating time, \(th\), and temperature is measured in the monitoring needle, 6 mm distant during heating and during the cooling period following heating. The readings are then processed by subtracting the ambient temperature at time 0, multiplying by \(4\pi\) and dividing by the heat per unit length, \(q\). The resulting data are fit to the following equations using a non-linear least squares procedure.

\[
T^* = b_0 t + b_1 Ei\left(\frac{b_2}{t}\right) \quad (1)
\]

\[
T^* = b_0 t + b_1 \left\{ Ei\left(\frac{b_2}{t}\right) - Ei\left[\frac{b_2}{t - th}\right]\right\} \quad (2)
\]

where:

\[
T^* = \frac{4\pi(T - T_0)}{q} \quad (3)
\]

\(^8\)Carslaw and Jaeger (1959) and Kluitenberg et al. (1993).
Here, $E_i$ is the exponential integral, and $b_0$, $b_1$ and $b_2$ are the constants to be fit. $T_0$ is the temperature at the start of the measurement and $q$ is the heat input. The first equation applies for the first $t_h$ seconds, while the heat is on. The second equation applies when the heat is off. Compute thermal conductivity from Equation 4 and diffusivity from 5.

\[ k = \frac{1}{b_1} \]  \hspace{1cm} (4)

\[ D = \frac{r^2}{4b_2} \]  \hspace{1cm} (5)

You can find the conductivity and diffusivity by fitting equation to the transformed data. The correct values of $b_0$, $b_1$ and $b_2$ are the ones which minimize the sum of squares of error between the equations and the measurements. Use the Marquardt (1963) non-linear least squares procedure to find the correct values. This procedure is susceptible to getting stuck in local minima and failing to find a global minimum in some problems (the single needle problem is a perfect example of a bad non-linear least squares problem) but the dual needle problem typically works well. The KD2 Pro can find the three model parameters quickly.

### 7.2 Single Needle Algorithm

Heat is applied to a single needle for a time, $t_h$, and temperature is monitored in that needle during heating and for an additional time equal to $t_h$ after heating. Two needle sizes are used; One (the KS-1) is 1.2 mm diameter and 6 cm long. The other (the TR-1) is 2.4 mm diameter and 10 cm long. The temperature during heating is computed from equation 6.

\[ T = m_0 + m_2 t + m_3 \ln t \]  \hspace{1cm} (6)

Where $m_0$ is the ambient temperature during heating (which could include some offset for contact resistance and the heating element being adjacent to the temperature sensor inside the needle), $m_2$ is the rate of background temperature drift, and $m_3$ is the slope of a line relating temperature rise to logarithm of temperature.

\[ ^9 \text{Abramowitz and Stegun, (1972).} \]
Equation 7 represents the model during cooling.

\[ T = m_1 + m_2 t + m_3 \ln \left( \frac{t}{t - t_h} \right) \]  

(7)

The thermal conductivity is computed from Equation 8.

\[ k = \frac{q}{4\pi m_3} \]  

(8)

Since these equations are long-time approximations to the exponential integral equations (Equation 1), we use only the final \( \frac{2}{3} \) of the data collected (ignore early-time data) during heating and cooling. This approach has several advantages. One is that effects of contact resistance appear mainly in these early-time data, so by analyzing only the later time data the measurement better represents the thermal conductivity of the sample of interest. Another advantage is that equations 5 and 6 can be solved by linear least squares, giving a solid and definite result. The same data, subjected to a non-linear least squares analysis, can give a wide range of results depending on the starting point of the iteration because the single needle problem is susceptible to getting stuck in local minima. The linear least squares computation is also very fast.

### 7.3 The Error (Err) Value

When heat at a constant rate, \( q \) is applied to the KD2 Pro needles, the temperature response of the sensor over time can be described by the equation 9.

\[ \Delta T = -\frac{q}{4\pi k} Ei \left( \frac{-r^2}{4Dt} \right) \]  

(9)

where \( k \) is the thermal conductivity of the medium in which the needle is buried, \( D \) is the thermal diffusivity of the medium, \( r \) is the distance between the heater and the sensor where temperature is measured, and \( Ei \) is the exponential integral. The KD2 Pro uses this equation to model temperature rise in the dual needle sensor, and uses just the first term of the exponential integral expansion (the logarithm of time) for the single probe sensors. Values of \( k \) and \( D \) are
sought which minimize the difference between model and measured values of temperature rise. Temperature of the needle is measured, so $\Delta T$ is first computed by subtracting the initial temperature from all readings. Temperature rise is further scaled by multiplying by $4\pi$ and dividing by $q$. If we call this new temperature variable $T^*$, then we find the values of $k$ and $D$ that minimize the sum of squares of error.

$$SSE = \sum (T^*_i - M^*_i)^2$$  \hspace{1cm} (10)

where the $T^*_i$ are the measured values and the $M^*_i$ are values modeled with Equation 9. Equation 11 shows the standard error of estimate for the measurements.

$$S_{yx} = \sqrt{\frac{SSE}{n}}$$  \hspace{1cm} (11)

where $n$ is the number of measurements. The units of $S_{yx}$ are $mC/W$. It can be made dimensionless if it is multiplied by the thermal conductivity, $k$. This dimensionless value gives the error in fitting the model to data as a value independent of heater current or the thermal conductivity of the medium. The KD2 Pro computes $err$ as in equation 12.

$$err = kS_{yx}$$  \hspace{1cm} (12)

It is a dimensionless measure of the goodness of fit of the model to the data. It can be converted to temperature by dividing by $k$ and multiplying by $q$.

**Note:** The Err term is not a rigorous statistical indicator of measurement quality, but it serves as a qualitative quality indicator.
8 Reference Materials

Decagon Application Notes

Note: You may find all application notes on our website at www.decagon.com.

“Finding the R Value of Insulation using the KD2”

“Heat and Water Transport in Soil”

“How Large Does my Sample Need to be for Thermal Properties Measurements?”

“How to Reduce Contact Resistance Errors in Thermal Properties Measurements”

“KD2 Pro Compliance to ASTM and IEE Standards”

“Methods, Instrumentation, and Standards for Measuring Thermal Properties in Soil, Rock and Concrete”

“Producing Thermal Dryout Curves for Buried Cable Applications”

“Reducing Contact Resistance Errors in KD2 Thermal Properties Measurements”

“Simultaneous Thermal Conductivity and Thermal Diffusivity Measurement of Foods”

“The Effect of Soil Thermal Resistivity (RHO) on Underground Power Cable Installations”

“The KD2 and KD2-Pro Thermal Properties Analyzers vs. ASTM and IEEE Standards”

“The Science of Grilling Meat”

“Thermal Resistivity of Porous Materials (Soils) Change with Changes in Density, Water Content, Temperature and Composition”

“Underground Power Cable Installations: Soil Thermal Resistivity (13476-00 AN)”

“Using the KD2 Pro to Measure Thermal Properties of Fluids”
References


Please visit [www.decagon.com/thermal](http://www.decagon.com/thermal) for more information on thermal properties in relation to density, water content, and temperature.
## Appendix A

### 9.1 Table of Thermal Units

Table 4: Table of Thermal Units

<table>
<thead>
<tr>
<th>Measurement</th>
<th>SI Unit</th>
<th>English Conversion Multiplier</th>
<th>English Unit</th>
<th>SI Conversion Multiplier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat</td>
<td>Joule</td>
<td>0.000948</td>
<td>BTU</td>
<td>1055</td>
</tr>
<tr>
<td>Heat</td>
<td>Joule</td>
<td>0.239</td>
<td>cal</td>
<td>4.187</td>
</tr>
<tr>
<td>Heat Flux Density</td>
<td>$\frac{W}{m^2}$</td>
<td>0.00146</td>
<td>$\frac{cal}{(cm^2\text{min})}$</td>
<td>697</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>$\frac{W}{m\cdot K}$</td>
<td>0.578</td>
<td>$\frac{BTU}{hr\cdot ft^oF}$</td>
<td>1.73</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>$\frac{W}{m\cdot K}$</td>
<td>6.93</td>
<td>$\frac{BTU\cdot in}{hr\cdot ft^2\cdot ^oF}$</td>
<td>0.144</td>
</tr>
<tr>
<td>Thermal Resistivity</td>
<td>$cm \cdot ^oC \cdot \frac{W}{W}$</td>
<td>0.0173</td>
<td>$\frac{ft\cdot hr\cdot ^oF}{BTU}$</td>
<td>57.8</td>
</tr>
<tr>
<td>Thermal Resistivity</td>
<td>$cm \cdot ^oC \cdot \frac{W}{W}$</td>
<td>0.00144</td>
<td>$\frac{ft^2\cdot hr\cdot ^oF}{BTU\cdot in}$</td>
<td>693</td>
</tr>
<tr>
<td>Specific Heat</td>
<td>$\frac{J}{kg\cdot K}$</td>
<td>0.000239</td>
<td>$\frac{BTU}{lb\cdot ^oF}$</td>
<td>4186.8</td>
</tr>
<tr>
<td>Diffusivity</td>
<td>$\frac{mm^2}{s}$</td>
<td>0.0388</td>
<td>$\frac{ft^2}{hr}$</td>
<td>25.794</td>
</tr>
<tr>
<td>Diffusivity</td>
<td>$\frac{m^2}{s}$</td>
<td>0.1076</td>
<td>$\frac{ft^2}{s}$</td>
<td>9.29</td>
</tr>
</tbody>
</table>
10 Appendix B

10.1 Send Feedback to Decagon

The KD2 Pro Utility Software makes it easy to send feedback, bug reports, and feature requests to Decagon or your Decagon Distributor. Choose “Send Feedback to Decagon...” from the Help menu. This opens the window shown in Figure 10.

![Send Feedback to Decagon](image)

Figure 10: Send Feedback to Decagon
Enter your name, company name, and other contact information. Tell us what type of feedback you are sending (General Feedback, Feature Suggestions, Bug Report, or Other). Indicate how you want us to respond to your feedback (E-mail or Telephone).

Use the description area to give details for your feedback. If you are reporting a bug, it is very helpful for you to tell us what steps you took for the bug to happen and any error message you saw. By default, bug reports also include the software error files.

You can send Decagon a file using this form too. This is useful for sending data files that you have questions about. If you work directly with a Decagon representative, put their E-mail address in the field at the bottom of the form. This sends the contents of the form to them. Your Decagon representative can follow-up with you directly.
11 KD2 Pro CE Compliance


Standards to which conformity is declared:
EN 61326-1:2013 and
EN 50581:2012

Manufacturer Name: Decagon Devices, Inc.
2365 NE Hopkins CT
Pullman, WA 99163 USA

Type of Equipment: Thermal Properties Meter

Model Number: KD2 Pro

Year of First Manufacture: 2006

This is to certify that the KD2 Pro Thermal Properties Meter, manufactured by Decagon Devices, Inc., a corporation based in Pullman, WA, USA meets or exceeds the standards for CE compliance as per the Council Directives noted above. All instruments are built at the factory at Decagon and pertinent testing documentation is freely available for verification.
Index

About Screen, 25
Accuracy, 6
Annotate, 19
Auto Mode, 25
  Setting, 37

Batteries
  Changing, 49
  Life, 5
Baud Rate
  Maximum, 32
Button
  Arrow Keys, 9
  Enter, 9
  Escape, 9
  Menu, 9
CE Compliance, 65
Clock
  Auto Synchronize, 33
Command Retries, 32
Communications
  Baud Rate, 32
  Force Find All COM Ports, 32
Contact Information, 3
Contrast
  Setting, 24
Customer Support, 2
Data
  Annotate, 18
  Discard, 18
  Download, 20
  Downloading, 28
  Erasing, 19, 21, 27
  Menu, 19
  Save, 18
  Storage, 5
Date
  Setting, 22, 37
Declaration of Conformity, 65
Email, 3
Error Log File, 64
Firmware Version, 25
KD2 Pro Overview, 1
KD2 Pro Utility
  Actions Menu, 34
  Auto Clock Synchronize, 33
  Column Headers, 31
  Command Retries, 32
  Downloading Data, 28
  Edit Menu, 30
  Erasing Data, 36
  Error Log File, 64
  Help Menu, 34
  Measurement Units for Data Files, 31
  Organizing Saved Data, 35
  Retrieving Status Information, 39
  Setting Date and Time, 37
  Setting the Auto Mode, 37
  Troubleshooting, 52
  Version Check, 33
Keypad Button Descriptions, 9
Liquids
  Temperature Control, 47
Measurements
  Insulation, 45
  Liquids, 45

Memory Capacity, 5

Menus
  Configuration Menu, 21
  Data, 19
  Main Menu, 17

Power Mode, 15, 24

Save, 18

Saving Data, 35

Seller’s Liability, 3

Sensor Kits, 2

Sensors
  Accuracy, 5
  Cleaning, 49
  Installation, 16
  Performance Verification, 50
  Types, 9

Septum, 50

Software Updates, 33

Specifications, 5

Taking a Measurement, 41

Theory, 55

Thermal Units, 62

Units
  Setting, 23

View Readings, 19

Warranty, 3